
   

 

   

 

PowerTeacher Pro Gradebook Training – Session 2 

Creating and Viewing Assignments 

View assignments on both the Assignments and Scoresheet pages.  You can set up assignments at the 

beginning of a school term or at any time during the term. To save time, duplicate existing assignments 

or create duplicates while creating a new assignment. 

To create an assignment: 

1. Click Create 

2. Select Assignment 

3. Open the Select Classes menu and select a class 

Click outside the Select Classes menu to close it. 

4. Enter the name of the assignment, such as Unit 1 Test 

5. Select Test as the category 

6. Select a score type, such as Points 

7. Enter the number of score entry points, such as 80 

8. To include the assignment in students’ final grades, verify that Count in Final Grade is selected 

9. Enter the assignment due date 

The default due date is today’s date. 

10.Enter a description (if you choose), such as This test covers all the topics in Unit 1 

11.Click the Students tab 

12.Verify that the assignment applies to all students 

To apply the assignment to a selection of students, click Add/Remove Students. Then clear the check 

box next to the Filter area and check the boxes next to the selected students’ names. 

13.Click the Publish tab 

14.Open the Publish Assignment menu and choose when to publish the assignment for students and 

parents 

15.To publish students’ scores once you’ve scored the assignment, check Publish Scores 

16.Click Save and Close at the bottom of the Create window 

Instead of closing the edit window, you could also copy the assignment by clicking Duplicate at 

the bottom of the Create window. 

Score the new assignment immediately by clicking Score Assignment in the alert at the top of the 

window. 



   

 

   

 

 

 

To duplicate an assignment for use in another class: 

1. Click Grading 

2. Select Assignment List 

3. In the list of assignments, locate an assignment that you’ve already created and click the Edit icon 

4. Click Duplicate at the bottom of the Edit window 

5. Open the Select Classes menu, clear the check box next to the currently selected class, and choose a 

different class 

Click outside the Select Classes menu to close it. 

6. Edit the duplicated assignment name by deleting the underscore and number that were appended to 

the end 

7. Use the same category, score type, score entry points, due date, description, and publication settings 

as the original assignment, or modify the values as needed 

8. Click the Standards tab 

9. Click Add/Edit Standards and, if needed, select a new setof standards that are aligned to this 

assignment 

10.To save the assignment and close the Edit window, click Save and Close 

11.To verify that you copied the assignment to a different class, click the name of the currently selected 

class in the navigation bar at the top of the page and select the class that you copied the assignment to 

12.Locate the duplicated assignment in the list of assignments 

 

Working with Grades 

When entering scores, make sure to use the type of score that you set up when you created the 

assignment. For example, use numbers for points and percentages or letters for letter grades. 

To enter scores: 

1. Click Grading 

2. Click Assignment List or Scoresheet 

3. From the Assignments or Scoresheet pages, enter a student’s assignment score by clicking in the cell 

where the student’s name intersects with the assignment name and type in the score 

Navigate sideways through the score columns by clicking the blue columns with left- or right-facing 

arrows at the end of the rows.  



   

 

   

 

View the summary above the list of assignments to see the selected assignment’s score type, as well as 

the student’s existing score (if the assignment was previously scored), and the due date. 

In the summary, click Edit Assignment to edit the assignment details. Click Show More to view 

additional information, such as the associated grade and special codes scales. 

  

To view additional metrics for a selected assignment on the Assignments page, or for all assignments on 

the Scoresheet page: 

1. Click the gear icon at the top of the page 

2. Click Show Metrics to view the mean, median, and mode statistics for the assignments or for the 

aligned standards 

Using the Score Inspector and Flags 

While you can enter scores manually, use the Score Inspector to provide more details about the 

student’s performance, such as when a student has a missing or late assignment. Also use the Score 

Inspector to enter a comment about a student’s score.  

Your district leaders may have associated a special codes scale to the regular grade scale. If that is the 

case, you can click Codes in the Score Inspector and select a special code, such as INC, to score a 

student’s assignment. In some cases, you may also see other system-generated icons that are related to 

standards grades. 

To open the Score Inspector, click in a score cell on the Assignments or Scoresheet pages. 

The following table provides brief explanations of the flags (score indicators) and other icons available in 

the gradebook. 

 

 

 

 

 

 

 

 

 

 

 



   

 

   

 

 

 

 

 

 

 

Scoring Assignments 

Use one of two methods to score an assignment—score a single assignment from the Assignments page, 

or score multiple assignments on the Scoresheet. 

To enter scores, flags, or comments for a single assignment: 

1. Click Grading 

2. Select Assignment List 

3. Click the name of an assignment 

4. Click in a student’s score cell and type a score, such as 72 

5. Save the scores 

To enter scores, flags, or comments for one or more assignments on the Scoresheet: 

1. Click Grading 

2. Select Scoresheet 

3. Click in a student’s blank score cell for the selected 

assignment and enter a score in the Score Inspector 

4. Click Save 

 

Working with Final Grades 

Final grades are updated automatically throughout the term as you enter assignment scores in the 

gradebook. When the term comes to a close, however, you may have additional tasks to perform before 

submitting grades for report cards to make sure that your final grades are accurate. For example, you 

may have to modify individual scores. Occasionally, you may also need to modify a student’s final grade 

in a course based on effort, participation, or other performance factors. 

To work with final grades, click Grading and use the links in the Grades section. Access the same links 

through the Quick Menu— the arrow next to the heading at the top of the grading pages. 



   

 

   

 

  

To modify a final grade: 

1. Click Grading 

2. Click Traditional 

3. Click a student’s final grade 

4. In the Score Inspector, edit the student’s grade. For example, change percentage of 91 to 94. 

5. Click Save 

Notice that the student’s final grade cell has a small triangle in the upper-left corner, which indicates 

that the grade has been modified manually. 

 

6. Open the Quick Menu and select Standards 

7. Click Save 

To revert to the calculated grade, click the Undo icon in theScore Inspector. To view additional standards 

metrics, click the gear icon at the top of the page and then select Show Metrics to view the mean, 

median, and mode statistics. 

Recalculating Final Grades 

Although final grades in PowerTeacher Pro are calculated automatically, you can force a recalculation, if 

necessary. Use the recalculate tool after making significant changes in the gradebook, such as adding 

multiple assignment scores for students who transferred from another class. Also, recalculate grades 

when your PowerSchool administrator changes a setting that affects the gradebook, such as the grade 

calculation formula, or when you assign an alternate grade scale to a student. 

To use the recalculate tool: 

1. Click Grading 

2. Select Traditional 



   

 

   

 

Or select Scoresheet, Standards, Comment Verification, Category Totals, or All Reporting Terms 

 under Grading. Under Students, click Assignments, Standards Progress, or Comment Log. 

3. Click the gear icon 

4. Select Recalculate Final Grades 

5. Select the classes in which you are recalculating grades 

6. To recalculate traditional grades, check Traditional Final 

Grades 

8. Click Recalculate 

 

Submitting Final Grades 

At the end of the term, notify your school’s PowerSchool administrator that you have finished entering 

the scores for the term and that final grades are ready to be stored. 

1. Select a class and verify that you are in the correct term 

2. Click Grading 

3. Select Traditional 

4. At the bottom of the page, click Final Grade Status 

5. When you have completed your final grades, check [Term] Final Grades are Complete 

6. Enter a comment indicating that final grades are complete, 

and click Save 

The green check mark next to "Final Grade Status" indicates that final grades are complete. 

               

If you aren’t done with final grades yet, leave the check box and comment box clear. 

Analyzing Class Progress 

To analyze the performance of an entire class, begin by selecting the class at the top of the gradebook 

window. Then, click Progress. Depending on how the gradebook is set up, you can view class progress 

on traditional grades and standards grades. 

Viewing Traditional Grades Progress 

To view traditional grades progress: 

1. From the Progress menu, select Traditional 



   

 

   

 

The graph on the Traditional Grades Progress page shows the distribution of grades for the class 

 for the selected reporting term. Click the information (i) icon to view the traditional grades 

 included in each color level. To the right of the graph, view a summary of the total number of 

 students who have missing, late, or incomplete assignments. 

               

2. Click View All to open the Traditional Grades Distribution window 

3. On the left side of the Traditional Grades Distribution window, view the grade distribution for each 

reporting term in the school year 

4. On the right, view the grade trends of the students in the class for the selected term, compared to the 

previous term 

A red arrow in the Grade column indicates that the student’s grade is trending down between 

 the selected terms. A green arrow indicates an upward trend, while no arrow indicates no 

 change. You can see which students are performing better or worse between terms. 

5. To compare trends between a different selection of subsequent terms, click a term in the Grade      

Distribution column 

6. Click the information (i) icon to view the grades included in each color level 

7. To close the window, click X in the upper-right corner 



   

 

   

 

 

 

 

 

Running PowerTeacher Pro Reports 

The gradebook contains reports that you can view onscreen or print. Personalize each report by 

entering a custom title or by including a top note, bottom note, or signature line. The following table 

provides brief descriptions of the reports: 



   

 

   

 

 

 

To run the Individual Student Report: 

1.  Click Reports 

2.  Select Individual Student Report 

3.  Enter a report title, such as Progress Report 

4.  Open the Select Classes menu and choose the classes to include on the report 

5.  To use a previously customized class name, check Use Custom Class Name 

6.  Since you are creating a progress report that includes students' course grades in only your class 

instead of all of their classes, leave the "Include Students' Full Schedules" check box clear 

7.  In the Sort Options section, open the Layout menu and choose By Section, By Student 

8.  To sort the report by students’ last names, open the Students menu and choose Last Name 

To use the preference for how student names are sorted by default in your gradebook that you 

 defined under Settings > Display Settings, choose Gradebook Preference. 

9.   Use the Assignments menu to sort the assignments by due date or by category and due date 



   

 

   

 

10. Open the Areas To Include menu and check Course Grade Comments and Assignment Comments to 

include any comments that you’ve entered about the students in the report  

"Course Grades and Attendance," Assignments, and Category Totals are checked by default.  

11. Click the Areas To Include menu again to close it 

12. Verify that Show Percentages is selected to include students’ grade percentages in the report 

13. To help with identifying students with the same name, add student numbers to the report by 

selecting Include Student Number with Student Name 

14. To include students’ grades from the current term, use the default settings under Date Range 

15. Use the default settings under Data Filters to include any assignments, any scores, any category, and 

any course grades 

16. Open the Students tab 

17. To run the report for a selection of students rather than for all of the students in the classes, click 

Add/Remove Students 

18. All of the students are selected by default, so clear the check box to the right of the Filter area, then 

in the list of students, check the boxes next to individual student’s names 

19. Scroll to the top of the page and click the Format tab 

20. Since you are including all of the available data in the report, leave the page orientation set to 

Landscape to make the text easier to read 

21. Use the default option PDF for the report output 

22. To create a page break between students, check Page Break 

23. Choose to exclude row shading to save ink during printing 

24. Leave the “Include” check box clear for the Top Note option, since you don’t plan to include a note 

at the top of the report 

25.Leave the “Include” check box clear for the Bottom Note option, since you don’t plan to include a 

note at the bottom of the report 

26.Clear the Signature Line check box, since you don’t need parents to sign the report 

27.To generate the report, click Run Report 



   

 

   

 

 

To run the Student Roster report for a class: 

1.  Open the menu at the top of the gradebook window and select a class 

2.  Click Reports 

3.  Select Student Roster 

4.  Enter a report title, such as Field Trip Roster 

5.  Since you selected a class before you navigated to the Reports menu, it is already selected for the 

Classes option 

6.  To sort the roster of students by last name, open the Students menu and choose Last Name 

7.  Add columns of student information by opening the Add Columns menu and clicking Add next to 

Gender and Grade Level 

8.  Click Add next to Blank twice to include a column for taking attendance and one for tracking 

participation (or whatever you need a column for).  A column titled “Name” is included by default to list 

the students’ names. 

9.  Click the Add Columns menu again to close it 

10. Enter Attendance as the title of the first blank column 

11. Enter Participation as the title of the second blank column 

12. Click the Students tab at the top of the page and verify that the report applies to all of the students 

in the selected class 

13. Scroll to the top of the page and click the Format tab 

14. Open the Orientation menu and choose Portrait 

15. Use the default option PDF for the report output.  To work with the data in a spreadsheet, choose 

Excel. 

16. Use the default settings for the rest of the format options 

17. To generate the report, click Run Report 

 


